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1 Visitor Management System Module Settings and Operation 
Guide. Introduction

On the page:

Purpose of the 
document
General information 
about the Visitor 
Management System 
module

 

1.1 Purpose of the document
This Visitor Management System Module Settings and Operation Guide is a reference manual designed for Visitor 
Management System module configuration technicians and operators. This module is part of an access control 
system (ACS) built on the ACFA PSIM Software System.

This Guide presents the following materials:

general information about the Visitor Management System module;
Visitor Management System module settings;
working with the Visitor Management System module

1.2 General information about the Visitor Management System module
The Visitor Management System software module is a component of an ACS built on the ACFA PSIM Software System 
and supports the following actions:

observe employees' and visitors' access to objects using automated access control systems and their 
movement about the objects in accordance with granted access levels;
configure user rights to edit and view departments and employees;
create and configure access levels for individual employees and entire departments;
create templates and stamps for electronic security passes for employees and visitors to protected objects.
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2 Licensing policy for Visitor Management System
If you acquire 1 license for this module, it will allow you to use any number of the Visitor Management System
objects on any number of computers (Servers/RAWs and Clients). The same license also opens the Access Manager 
reports object under the Web Report System object so that you could use corresponding reports after WEB Report 
System PSIM installation (for more information, see WEB Report System PSIM. User Guide). In addition, the license 
allows the use of all integrated control readers (see Control Readers Settings Guide).

https://docs.axxonsoft.com/confluence/display/rptPSIM100en/Axxon+PSIM+WEB+Report+System+1.0
https://docs.axxonsoft.com/confluence/display/acfaPSIM100en/Control+Readers+Settings+Guide


ACFA PSIM 1.1 – Visitor Management System Module Settings and Operation Guide

Starting and stopping the Visitor Management System software module– 7

1.

2.

3.
a.

b.

3 Starting and stopping the Visitor Management System software 
module

3.1 Starting the Visitor Management System software module
To start the Visitor Management System software module, do the following:

Create a Visitor Management System object based on the Screen object on the Interfaces tab of the 
System Settings dialog.

Go to the Visitor Management System object's settings pane.

Specify the position parameters for the Visitor Management System module's window:
Check the Fix position box if you need to keep the module's window in a specific place on the 
desktop.

To configure the position of the Visitor Management System software module's window, specify the 
coordinates of the window's upper left corner in the X and Y fields and its width and height in the W
and H fields.
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4.

1.

2.

Click the Apply button.

Performing these actions will result in the Visitor Management System module's window being displayed on the 
screen.

3.2 Stopping the Visitor Management System software module
To stop the Visitor Management System software module, do one of the following three actions:

Click the  button on the ACFA PSIM Software System's main control panel and select the Close all menu 
item.

Click the  button in the upper right corner of the Visitor Management System software module's window.

Note:

 Subsequently, the Visitor Management System software module will be started automatically after the 
ACFA PSIM Software System is started.



Note:

 After using this method to stop the module, you must restart the ACFA PSIM Software System to 
start the Visitor Management System software module again.


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3. Go to the File menu and select Exit.

Note:

 After using this method to stop the module, you must restart the ACFA PSIM Software System to start the 
Visitor Management System software module again.


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1.

2.
a.

b.

4 Visitor Management System software module settings

4.1 Basic settings of the Visitor Management System software module
The Visitor Management System software module's basic settings are configured as follows:

Go to the Visitor Management System object's settings pane.

Specify the department access parameters for Visitor Management System operators:
Select the access level for viewing departments from the View dropdown list (1).

Access levels for viewing departments:

Access level Description

All All department properties are viewable

Some Information about department access levels is unavailable 
for viewing

No Departments are not viewable

Select the access level for editing departments from the Edit dropdown list (2).
Access levels for editing departments:
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c.
d.
e.

3.
a.

b.
c.

4.

5.

6.

Access level Description

All All department properties are editable

Some Editing department access levels is unavailable

No No department properties are editable

Check the Add box to grant access to add new departments (3).
Check the Delete box to grant access to delete departments (4).
Set the Add new departments checkbox to add new created departments to the Visitor Management 
System module automatically (5).

Specify the user access parameters for Visitor Management System operators:
Select the access level for editing users from the Edit dropdown list (1).

Access levels for editing users :

Access level Description

All All user properties are editable

Some Editing user access levels is unavailable

No No user properties are editable

Check the Add box to grant access to add new users (2).
Check the Delete box to grant access to delete users (3).

In the list of departments, check each department that should be available to a Visitor Management System
module operator.

In the Access levels field, check each access level that should be available to a Visitor Management System
module operator.

Check the Create users with antipassback box if users should be created with a feature activated that 
monitors double-entry.
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7.

8.

9.

10.

11.

12.

13.

14.

15.
16.
17.

18.

To enable the ability to view and edit access parameters, check the View access parameters and Edit 
access parameters boxes, respectively (1).

Check the Discharge access card box to allow the Visitor Management System module operator to close 
(delete) users' security passes (2). Discharging of the user access cards is described in Canceling user cards
section.
Check the Print access card box to all the Visitor Management System module operator to print security 
passes from the module's window using the system's default printer (3).

Check the Export data and Import data boxes to allow the Visitor Management System module operator to 
import and export data using the integrated ACFA PSIM Software System utilities and the corresponding 
software module (4).
Use the spinbox buttons to specify the number of additional access levels available to the Visitor 
Management System module operator (5).
Check the Set expiry date box if the period of the additional access level should be added and taken into 
account (6).
From the Camera dropdown list, select the video camera that will be used to capture a picture for the 
security pass (1).

If the selected video camera is connected through a video gateway, select the gateway from the 
corresponding dropdown list (2).
Select the ACS reader that will be used to read codes from user cards from the Reader dropdown list (3).
Check the Confirm card entered by operator box if user card assignments must be confirmed (4).
If events occurring in the Visitor Management System software module should be displayed on all screens on 
which a Visitor Management System object has been created, check the Send to all screens box (5).

Click the Apply button.

This completes the process of configuring the basic settings of the Visitor Management System software module.

Note:

The utility ARPEdit.exe, which is included with the ACFA PSIM Software System, is used to edit the 
printing format.



For example:

 If users add access cards to the system using the Visitor Management System module and an 
access control reader, and the reader is configured such that operator confirmation of entry is 
required (e.g. the Confirm card entered by operator box is checked), then when the Send to all
screens box is checked a window prompting to add will appear on all screens where the Visitor 
Management System module is available.


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1.

4.2 Advanced settings of the Visitor Management System software 
module

The Visitor Management System software module's advanced settings are configured as follows:

Go to the Visitor Management System object's settings pane.
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2.

3.

a.

b.
4.

5.
a.

b.

c.

6.
a.

b.

Click the Configure button in the Advanced settings field
The Advanced settings window will open.

In the Viewed fields settings group, configure how fields are displayed on the user pane for different 
departments:

On each tab check the box next to the fields to be displayed on the user pane of the corresponding 
department (1).

 If user access levels should be displayed, check the corresponding box (1).
If the Scanning documents application in the Visitor Management System module should be activated, check 
the corresponding box.
Configure the interface of the Scanning documents interface:

In the Documents (tabs) settings group, check the boxes next to the actions that the Visitor 
Management System module operator will be allowed perform with documents in the Scanning 
documents application (2).
 In the Pages (images) settings group, check the boxes next to the actions that the Visitor 
Management System module operator will be allowed perform with images in the Scanning 
documents application (2).
To enable the ability to assign a photograph to users from the Scanning documents application, 
check the Assign picture to employee box (2).

Configure the criteria for duplicate records:
Check the Set parameters for duplicate records box if Visitor Management System module operator 
should be warned about duplicate user accounts when creating a new record (3).
Set the radio button to the desired criteria for identifying duplicate records.
Criteria for duplicate records:

Criteria Description

Note:

If all basic fields or all advanced fields should be displayed, check the All fields and All extra 
fields boxes, respectively.


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7.

8.

Surname only A new record will be considered a duplicate if the user's 
surname matches that of a previously created user.

Name only A new record will be considered a duplicate if the user's 
name matches that of a previously created user.

Patronymic only A new record will be considered a duplicate if the user's 
patronymic matches that of a previously created user.

Name and surname A new record will be considered a duplicate if the user's 
name and surname match those of a previously created user.

Full name A new record will be considered a duplicate if the user's full 
name matches that of a previously created user.

To save changes and return to the Visitor Management System object's settings pane, click Save.

Click Apply on the Visitor Management System object's settings pane.

This completes the process of configuring the advanced settings of the Visitor Management System software 
module.

Note:

To return to the Visitor Management System object's settings pane without saving changes, click 
Cancel.


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1.
2.
3.

5 Visitor Management System software module interface

5.1 Basic elements of the Visitor Management System software module
The Visitor Management System software module's interface consists of three basic elements:

ACS bar (1);
Information pane (2).
Toolbar (3);

5.1.1 ACS bar
The ACS bar is designed for switching between the sections of the software module. It displays the hierarchical 
department tree.

The ACS bar supports editing of the department tree by adding, deleting, and renaming departments, if the module 
operator possesses the appropriate rights.

Switching to any section of the software module changes the information pane.
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1.
2.
3.
4.

1.

5.1.2 Information pane
The information pane is designed to display and edit existing (created) time zones, access levels, holidays, shift 
schedules, departments, and all users of the selected department.

5.1.3 Toolbar
The toolbar is designed to switch between the ACS bar and the search bar. The toolbar also supports the following 
actions:

Start the Scanning documents application.
Start printing a user access card.
Assign a photograph to a user.
Change the appearance of the information pane.

5.2 Visitor Management System software module interface settings

5.2.1 Configuration of the appearance of the menu and toolbar
To configure the appearance of the Visitor Management System software module's menu and toolbar, do the 
following:

Go to the Service menu.
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2.

3.
4.

5.
6.
7.
8.
9.

10.
11.

12.

13.

14.

15.

Select the Setting… menu item.
The Setting window will open.

Check the Always show full menu box if all menu items should be shown immediately (1).
Check the Show full menu after short delay box if all menu items should be shown after holding the mouse 
cursor over the down button for a while(2).
Check the Highlight rarely used commands box if rarely used menu items should be highlighted (3).
Check the Use animation when expanding menu box if the menu should be animated when it expands (4).
Check the Show menu shades box if the menu should cast shadows (5).
Click the Reset command usage statistics button to reset menu item usage statistics ( 6).
Check the Large icons in toolbars box if large icons should be used in the toolbar (7).
Check the Large icons in menu box if large icons should be used in the menu (8).
Check the Show tooltips for commands in toolbars box to display tooltips when the mouse cursor hovers 
over an icon on a toolbar (9).
Check the Show tooltips for commands in menu box to display tooltips when the mouse cursor hovers 
over a menu item (10).
Check the Add keyboard shortcuts to tooltips box to include the keyboard shortcut for actions in tooltips 
(11).
Select the desired menu animation from the Menu output effect dropdown list (12).

To save any changes made, click the Apply button.

This completes the process of configuring the appearance of the menu and toolbar.

5.2.2 Configuration of the Visitor Management System module's window style
The Visitor Management System module's window style is configured as follows:

Note:

If animations are not required, select None.


Note:

To cancel your changes, click the Cancel button.

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1.

2.

1.
a.

b.

c.

2.
a.

b.

Go to the Service menu.

Select the menu item that corresponds to the desired style.

This completes the process of configuring the Visitor Management System module's window style.

5.2.3 Configuration of the information pane's view
The information pane's view is configured in three ways:

Using the information pane's context menu:
Go to the section of the Visitor Management System software module which is to have its view 
configured by clicking with the mouse on the desired item in the ACS bar.
Right-clicking anywhere on the information pane will bring up the context menu.

Select the View menu item and select the desired view for the information pane from the flyout 
menu.

Using the toolbar:
Go to the section of the Visitor Management System software module which is to have its view 
configured by clicking with the mouse on the desired item in the ACS bar.

Click the  button on the toolbar.
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c.

3.
4.

5.

6.

Select the desired view for the information pane from the dropdown menu.

Using the menu:
Go to the section of the Visitor Management System software module which is to have its view configured by 
clicking with the mouse on the desired item in the ACS bar.
Go to the View menu.

Select the View menu item and select the desired view for the information pane from the flyout menu.

This completes the process of configuring the information pane's view.

5.2.4 Visitor Management System software module pane display settings
The display of the Visitor Management System module's panes is configured as follows:
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1.

2.
3.
4.
5.

1.
2.

Go to the View menu.

To display the menu, put a check next to Menu bar item by clicking on it (1).
To display the menu, put a check next to the Menu bar item by clicking on it (1).
To display the interface style selection pane, put a check next to the Interface bar item by clicking on it (1).
To display the status bar below the Visitor Management System module's window, put a check next to the 
Status bar item by clicking on it (2).

This completes the process of configuring the display of the Visitor Management System software module's panes.

5.2.5 Moving the Visitor Management System software module's panes
To enable the movement of the Visitor Management System module's panes, put a check next to the Allow bar 
moving by clicking on the corresponding item in the Service menu.

 

Movement of the Visitor Management System software module's panes is configured as follows:

Left-click the pane's header with the mouse.
While holding down the left mouse button, move the mouse cursor to the desired area of the Visitor 
Management System module's window.
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3. Release the left mouse button.

Following these steps will result in the pane being moved to the specified location.
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1.

2.

6 Working with the Visitor Management System software module

6.1 Working with time zones
In the Visitor Management System software module, a time zone defines the time interval in which users access 
objects. A single time zone can contain several time intervals.

6.1.1 Creation of a time zone
A time zone is created as follows:

Go to the Time zones section of the ACS bar.

The information pane will show previously created time zones and the time zone bar will open.

Click the New button (1).

Note:

This action can also be performed using the information pane's context menu. Right-click on any 
point in the information pane to bring up the context menu and then select the New menu item.


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3.
4.

a.
b.
c.
d.

5.

1.

2.

3.
4.

In the Name field, enter the name of the time zone (2).
Configure the time zone's intervals. For each interval, do the following:

In the Beginning column of the table, enter the time interval's start time in HH:MM:SS format (3).
In the Ending column of the table, enter the time interval's end time in HH:MM:SS format (4).
To include a day of the week in the time interval, check the box in the corresponding column (5).
Check the Holidays box to include holidays in the time interval (5).

Click Save to save the time zone (6).

The completes the process of creating a time zone.

6.1.2 Editing a time zone
A time zone is edited as follows:

Go to the Time zones section of the ACS bar.

Select the desired time zone in the information pane by clicking on it with the left mouse button.

Go to the time zone bar and make the desired changes.
Save the changes by clicking Save.

This completes the process of editing a time zone.

6.1.3 Deleting a time zone
A time zone is deleted as follows:
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1.

2.

3.

4.

1.

Go to the Time zones section of the ACS bar.

Select the desired time zone in the information pane by clicking on it with the left mouse button.

Click Delete on the time zone bar.

Click Yes to confirm the deletion.

The completes the process of deleting a time zone.

6.2 Working with shift schedules

6.2.1 Creation of a shift schedule
A shift schedule is created as follows:

Go to the Shift work section of the ACS bar.

Note:

This action can also be performed using the Delete item in the information pane's context menu.

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2.

3.
4.
5.
6.

7.
a.
b.
c.

8.

The information pane will show previously created shift schedules and the shift work schedule bar will open.

Click the New button (1).

In the Name field, enter the name of the shift schedule (2).
Specify the shift's start date in the Shift start field in DD.MM.YYYY format (3).
Check the Skip holidays box to ignore holidays (4).
In the Shift time spinbox, use the up/down buttons to enter the total number of days in the shift schedule, 
including days off (5).

Configure the shift schedule's workdays. For each day, do the following:
In the Shift day column, enter the shift day's index number (7).
In the Beginning column of the table, enter the workday's start time in HH:MM:SS format (8).
In the Ending column of the table, enter the workday's end time in HH:MM:SS format (9).

Click Save to save the shift schedule (10).

This completes the process of creating a shift schedule.

6.2.2 Editing a shift schedule
A shift schedule is edited as follows:

Note:

This action can also be performed using the information pane's context menu. Right-click on any 
point in the information pane to bring up the context menu and then select the New menu 
item.



Note:

The current shift day is displayed in the corresponding field (6).

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1.

2.

3.
4.

1.

2.

3.

Go to the Shift work section of the ACS bar.

Select the desired shift schedule in the information pane by clicking on it with the left mouse button.

Go to the shift work schedule bar and make the desired changes.
Save the changes by clicking Save.

This completes the process of editing a shift schedule.

6.2.3 Deleting a shift schedule
A shift schedule is deleted as follows:

Go to the Shift work section of the ACS bar.

Select the desired shift schedule in the information pane by clicking on it with the left mouse button.

Click Delete on the shift work schedule bar.

Note:

 This action can also be performed using the Delete item in the information pane's context menu.

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4.

1.

2.

3.

Click Yes to confirm the deletion.

This completes the process of deleting a shift schedule.

6.3 Working with holidays
Holidays can be included in time zones and shift schedules.

6.3.1 Assigning holidays
Holidays are assigned as follows:

Go to the Holidays section of the ACS bar.

The pre-holiday bar will open in the information pane.

Enter the dates of the holidays in DD.MM.YYYY format in the Day column (1).

To save any changes made, click the Save button (2).

This completes the process of assigning holidays.

6.3.2 Deleting holidays
Holidays are deleted as follows:

Note:

 Holidays must not be duplicated.

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1.

2.

3.
4.

Go to the Holidays section of the ACS bar.

The pre-holiday bar will open in the information pane.

Bring up the holiday context menu. Do this by left-clicking with the mouse in the corresponding table cell.

Select the Delete record menu item.
To save any changes made, click the Save button (2).

This completes the process of deleting holidays.

6.3.3 Search for holidays by date
Search for holidays by date as follows:
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1.

2.

3.

4.
a.

Go to the Holidays section of the ACS bar.

The pre-holiday bar will open in the information pane.

Bring up the holiday context menu. Do this by left-clicking with the mouse in the corresponding table cell.

Select the Find menu item.
The Search window will open.

Specify the search parameters:
In the Sample field, enter the search query (a complete or partial holiday date) (1).
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b.
c.

d.
e.
f.

5.

6.
7.

Select the direction of holiday search from the View dropdown list (2).
Select the search type from the Match dropdown list (3).

Search type Description

Whole field The search will find holidays with dates that entirely match 
the search query

Field beginning The search will find holidays with dates that begin with 
values that match the search query

Any field part The search will find holidays with dates that contain the 
search query

To perform a case sensitive search, check the corresponding box (4).
To perform a field-format sensitive search, check the corresponding box (5).
To search only in the current field (e.g. the field from which the context menu was brought up), check 
the corresponding box (6).

Click the Find button to begin the holiday search (7).
If no matching dates are found, a message about the unsuccessful search will appear in a popup window.

If a matching holiday is found, then a  icon will appear next to it in the list.

To continue the search, click the Find next button (8).
To end the search and close the search window, click Close (9).

This completes the process of searching for holidays.

6.4 Working with access levels
In the Visitor Management System software module an access level is a set of special restrictions defined by users' 
rights to access and move about a protected object.

An access level determines which access point (reader) for a given time zone (shift schedule) will provide user 
access and, if necessary, forward cards to a controller and armed/disarmed for an object.

6.4.1 Creation of an access level
An access level is created as follows:
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1.

2.

3.
4.

Go to the Access level section of the ACS bar.

The information pane will show previously created access levels and the access level bar will open.

Click the New button (1).

In the Name field, enter the name of the access level (2).
In the Access point column of the table, select the reader through which user access will take place (3).

Note:

This action can also be performed using the information pane's context menu. Right-click on any 
point in the information pane to bring up the context menu and then select the New menu item.



Note:

Each reader can only be used once. An error message will appear if you attempt to use a reader 
multiple times. 


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5.

6.

7.

8.

9.

1.

2.

3.
4.

In the table's Time zone column, select the time zone (or shift schedule) in which access will take place 
through the access point (4).
Check the box in the table's Card transfer column to forward access cards to the controller after an access 
card has been presented by a user (5).
Check the box in the table's Arm column to arm the access point after an access card has been presented by 
a user (5).
Check the box in the table's Disarm column to disarm the access point after an access card has been 
presented by a user (5).
Click Save to save the access level (6).

This completes the process of creating an access level.

6.4.2 Editing an access level
An access level is edited as follows:

Go to the Access level section of the ACS bar.

Select the desired access level in the information pane by clicking on it with the left mouse button.

Go to the access level bar and make the desired changes.
Save the changes by clicking Save.

This completes the process of editing an access level.

6.4.3 Deleting an access level
An access level is deleted as follows:
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1.

2.

3.

4.

1.
a.

Go to the Access level section of the ACS bar.

Select the desired access level in the information pane by clicking on it with the left mouse button.

Click Delete on the access level bar.

Click Yes to confirm the deletion.

This completes the process of deleting an access level.

6.5 Working with departments

6.5.1 Creation of a department
There are two ways to create a department in the Visitor Management System software module:

Using the context menu on the ACS bar:
Go to the Departments section of the ACS bar.

Note:

This action can also be performed using the Delete item in the information pane's context menu.

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b.

c.

2.
a.

b.

c.

Bring up the context menu by right-clicking on the Departments section.

Select Create department and select the desired department type from the flyout menu.
This completes the process of creating a department.

Using the information pane's context menu:
Go to the Departments section of the ACS bar.

Bring up the context menu by right-clicking on any point on the information pane.

Select the New menu item.

This completes the process of creating a department.

6.5.2 Assignment of department properties
Department properties are assigned on the department properties pane. This pane is displayed on the ACS bar 
when selecting any department.

Attention!

 This method only creates Employee-type departments

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Department properties are assigned as follows:
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1.

2.
3.
4.

5.

6.

In the External ID field, enter the department's external identification number (1)

In the Name field, enter the name of the department (2).
Select the department type from the Type dropdown list (3).
Select the department's access level from the Access level dropdown list (4).

In the Extra AL fields, specify the department's additional access levels, if any have been set up in the 
software module (6). See also Basic settings of the Visitor Management System software module.
Click Save to save the changes (7).

This completes the process of assigning department properties.

6.5.3 Building a department hierarchy
By default, a department is created as a base department, i.e. a parent department. To build a hierarchical 
department structure, change department parents as desired.

Department parents are changed as follows:

Note:

The number of employees in the department is indicated in the corresponding field (5).

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1.

2.

3.
4.

Bring up the context menu of the desired department on the ACS bar or the information pane.

Select the Change parent... menu item.
The Change department parent window will open.

Click on the department to be designated the parent department for the selected department.
Click OK.

This completes the process of changing the department parent.

6.5.4 Department search
Departments are searched as follows:
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1.

2.

3.
4.

Bring up the context menu of the Departments section.

Select the Find department... menu item.
The Search window will open.

Enter the complete or partial name of a department in the field (1).
Click the Find button (2).

If the search is successful, the matching department is selected on the ACS bar. Otherwise, a message about the 
unsuccessful search will appear in a popup window.

 

This completes the process of searching for a department.

6.5.5 Sorting the list of departments on the ACS bar
To sort the list of departments on the ACS bar alphabetically, do the following:
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1.

2.

3.

1.
a.

Go to the Departments section of the ACS bar.

Bring up the context menu.

Select the Sort menu item.

This will sort the list of departments alphabetically.

6.5.6 Deleting a department
There are two ways to delete a department in the Visitor Management System software module:

Using the context menu on the ACS bar:
Go to the Departments section of the ACS bar.
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b.

c.

2.
a.

b.

c.

Bring up the context menu of the department to be deleted.

Select the Delete menu item.
This completes the process of deleting a department.

Using the information pane's context menu:
Go to the Departments section of the ACS bar.

In the information pane, bring up the context menu of the department to be deleted.

Select the Delete menu item.
This completes the process of deleting a department.
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1.
2.

3.

4.

6.6 Working with users

6.6.1 Creating a user
A user is created as follows:

On the ACS bar, go to the department in which the user is to be created.
In the information pane, bring up the context menu by right-clicking on any point on any empty space in 
pane.

Select the New menu item.
The user pane is displayed below the information pane.

Specify the required user properties (1).

  Field Format Description

1 Number Text field User number

2 Personnel Text field User personnel number

3 External ID Text field User ID in the external database

Note:

Depending on the type of department the user belongs to, the user pane will be named as follows: 
Employee bar, Client bar, etc.





ACFA PSIM 1.1 – Visitor Management System Module Settings and Operation Guide

Working with the Visitor Management System software module– 43

  Field Format Description

4 Surname Text field User's surname

5 Name Text field User's name

6 Patronymic Text field User's surname

7 Passport Text field Passport number

8 License Text field Driver's license number

9 Department Dropdown list Department to which the user belongs

10 Position Text field User's position

11 Telephone Text field Telephone number

12 Make Text field Make of user's car

13 Number Text field User's car number

14 User locked Checkbox Yes – the user is locked.
No – the user is active.

15 Antipassback Checkbox Yes – anti-passback enabled.
No – anti-passback disabled.

16 Object code Text field Facility code of the user's access card

17 PIN Text field PIN code of the user's access card

18 Card Text field User's access card number

19 Card lost__times Text field Number of times the user has lost his or 
her access card

20 Issued by Text field Employee who issued the access card to 
the user

21 Expiry date Text entry or date selector Date the user's access card expires

22 Issue date Text entry or date selector Date the access card was issued to the 
user

23 Access level Dropdown list User's access level.
If Group access level is selected, the user 
is assigned the access level of the 
department to which he or she belongs.
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  Field Format Description

24 AL assigned by Text field Employee who assigned the access level 
to the user

25 Temporary AL Dropdown list Temporary access level

26 From Text entry or date selector Start date for the temporary access level

27 To Text entry or date selector End date for the temporary access level

28 From where (visitor bar 
only)

Text field Name of organization to which the 
visitor belongs

29 To where (visitor bar 
only)

Dropdown list Department being visited

30 To whom (visitor bar 
only)

Dropdown list Employee being visited

31 Extra AL Dropdown list Additional access level of employee

32 Extra temporary AL Dropdown list Additional temporary access level of 
employee

Note:

The object code and card code of the user's temporary access card are entered in the Object code
and Card code fields after the main access card's object code and card code, separated by a space.



Note:

 To display data in the External ID field, check the Export data and Import data on the Visitor 
Management System object's settings pane (4).



Attention!

Assigning of several access levels to employee is possible only in the following ACS systems: 
ApolloSDK, Elsys, ParsecNet, HID, Suprema, Salto, Perco S20. The prioritization of user access levels 
depends on the settings of a particular system.


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5.

6.

7.
8.

1.

Go to the Extra tab.

Specify the advanced user parameters (1).

If needed, enter additional user information in the corresponding field (2).
Click the Save button (3).

This completes the process of creating a user.

6.6.2 Transferring a user to a different department
There are two ways to transfer a user from one department to another:

Using the user pane, which opens by double-clicking on the user in the information pane:

Note:

The addition of advanced parameters to the user pane is described in Adding additional user 
parameters.


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a.

b.

2.
a.

From the Department dropdown list, select the department to which the user is to be transferred (1).

Click the Save button (2).
This completes the process of transferring a user from one department to another.

Using the information pane's context menu:
Bring up the user context menu.
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b.

c.
d.

1.
2.

1.

2.

Select Transfer employee to another department… 
The Transfer employee to another department window will open.

Select the department to which the user is to be transferred.
Click OK.
This completes the process of transferring a user from one department to another.

6.6.3 Assigning a photograph to a user
There are two ways to assign a photograph to a user:

By selecting a photograph from a file.
By capturing a picture from a video camera.

Selecting a photograph from a file
To select a photograph from a file, do the following:

Go to the user pane and click Assign picture.

Select the Select picture from file… menu item and select a file with the user's photograph in the window 
that opens.

The selected photograph will subsequently be displayed in the user pane.
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1.

2.

3.

4.

Capturing a picture from a video camera
To capture a picture from a video camera, do the following:

Go to the user pane and click Assign picture.

Select the Take picture from camera… menu item.
The Picture from camera window will open.

Use the Enter button to capture a picture from the video camera (2).
The captured frame will be displayed in the right side of the window.

Click the OK button (1).

The captured picture will subsequently be displayed in the user pane.

Note:

 To save changes, click Save on the user pane.


Note:

To rotate the image by 90 degrees, check the Flip checkbox (3).


Note:

To save changes, click Save on the user pane.

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1.
2.

1.

2.

Creating a single photograph database
ACFA PSIM supports storing user photographs on several computers.

ACFA PSIM advanced settings utility tweaki.exe is used to create a single photograph database. There are two ways 
to launch the tweaki.exe utility:

From the Windows Start menu: Start ->All Programs ->Axxon PSIM ->Utilities ->Advanced settings.
From the Tools folder of the ACFA PSIM installation directory: <Axxon PSIM installation 
directory>\Tools\tweaki.exe .

To configure the creation of a single photograph database, do the following:

Select the Visitor Management System mode in the Axxon PSIM Advanced Setup window (1).

In the System identifier column, enter the names of the computers that will store the photographs assigned 
by a user using the Visitor Management System module (2).

Note

The specified computers must be connected to the Axxon PSIM Server. Detailed information about 
configuring server connections is given in Axxon PSIM Software System: Administrator's Guide. 
However, the Visitor Management System module does not have to be installed on the specified 
computers.



Note

 Only photographs that have been newly added using the Visitor Management System module will 
be placed on the specified computers. Photographs added to the system before the configuration 
of the creation of a single photograph database will not be distributed to these computers.



Note

https://docs.axxonsoft.com/confluence/display/PSIM100en/Administrator%27s+Guide
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3.

1.

2.

3.

4.

Click the OK button (2).

This completes the process of configuring the creation of a single photograph database.

6.6.4 Printing a user access card
A user access card is printed as follows:

Go to the user pane.

Click Print access card.
The Print window will open.

From the dropdown list, select the template for printing the access card (1).

Click the Print button (2).

This completes the process of printing a user access card.

6.6.5 User search

Searching for users happens on the search bar, which is brought up by click the  on the ACS bar.

There are two ways to perform a user search:

Photographs will be stored on both the computers specified using the tweaki.exe utility as well as 
the computer from which photographs are added. Added photographs are stored in: <Axxon PSIM
installation directory>\Bmp\Person.

Note:

Print templates are prepared in the utility ArpEdit, which is included with the Axxon PSIM Software 
System in <Axxon PSIM installation director>/Tools/Arpedit/. A description of the utility is given in 
ArpEdit.pdf.


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1.

a.

b.
c.
d.

e.
f.

g.
h.
i.
j.

Specify the search parameters:

In the Search for field, enter the word or value to be searched for (1).

From the Search in dropdown list, select the type of departments that will be searched ( 2).
From the Field dropdown list, select the field that will be searched (3).
Select the search type from the Match dropdown list (4).

Search type Description

Whole field A search that will find users for which the search field 
entirely matches the value entered in the Find what field.

Field beginning A search that will find users for which the start of the search 
field matches the value entered in the Find what field.

Any field part A search that will find users for which the search field 
contains the value entered in the Find what field.

In the Maximum size field, enter the maximum number of results to be displayed (5).
Check the Extra fields box if the search parameters should include other values and fields (6).
Click Add to add a field (7).
 From the dropdown list, select the field that will be searched (8).
Enter the value that should be contained in the selected additional field (9).
In the Or columns, enter other values that the selected additional field may contain (10).
This completes the process of specifying the search parameters.

Note:

The search is not case sensitive.

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2. Start the search by clicking Find (1).

 

After the search has finished, users that match the specified search criteria will be displayed in the information 
pane. The number of matching users will be indicated in the lower left corner of the pane.

This completes the process of searching for users.

6.6.6 Adding additional user parameters
The Visitor Management System software module supports adding additional user parameters.

To add additional parameters, add rows to the OBJ_PERSON table and update ACFA PSIM database.

Additional parameters are added as follows:

Note:

An example of a search with additional parameters is given below.
The following parameters have been specified for the search:
a substring search to find the value Ivanov in the Surname field in Employee-type
departments. The additional field Card and values 4154 and 4122 have been specified.
Search results:
the search returns users from Employee-type departments who have a surname that 
contains Ivanov and whose Card field is equal to 4154 or 4122.



Note:

To stop a search, click the Stop button (2). To specify new search parameters, click the New button (3).


Attention!

ACFA PSIM must not be running when adding additional fields.

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1.

2.

3.

Open the ddi.exe utility located in <Axxon PSIM installation directory>/Tools/.

Open Axxon PSIM.exe.dbi by selecting Open in the File menu (1).

Go to the DBI tab (2) and select the OBJ_PERSON table (3).

Attention!

This file is currently not included in ACFA PSIM. Contact AxxonSoft customer support to receive 
Axxon PSIM.exe.dbi. The file should be placed in ACFA PSIM installation directory.


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4.

a.
b.
c.
d.

5.
6.
7.

To create a new field fill the row marked with the * :

Enter the field name (1).
Select the type of the field being added from the Type dropdown list (2).
 In the Size field, enter the size in bytes of the field being added (3).
In the Description field, enter the name of the field being added, which will be displayed in the Visitor 
Management System software module's window (4).

Add the required number of fields.
Save the changes to file by selecting Save in the File menu (1).
Update ACFA PSIM database:
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a.

b.
c.

8.

Open the idb.exe utility located in ACFA PSIM installation directory.

Click the Update database button (1).
After the database update is complete, click OK (2).

Start ACFA PSIM and the Visitor Management System software module, and go to the Extra tab on the user 
pane.

The added parameters will be displayed in the Visitor Management System software module's window.

This completes the process of adding additional parameters.

6.6.7 Scanning user documents
Scanning user documents is performed in the Scanning documents application. Working with the Scanning 
documents application is described in Working with the Scanning documents application.

6.6.8 Canceling user cards
If a user belongs to the Visitors group, his or her access card can be canceled.

To cancel a visitor's access card, do the following:
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1.

2.
3.

1.
a.

b.

Go to the visitor bar.

Click Discharge card.
Confirm the cancellation of the access card by clicking Yes.

As a result, the user will be deleted from the Visitors department.

This completes the process of canceling a user's access card.

6.6.9 Deleting a user
A user can be deleted in two ways:

Using the context menu:
In the information pane, bring up the context menu of the user to be deleted.

Select the Delete menu item.
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c.

2.
a.

b.
c.

Confirm the deletion by clicking Yes.

This completes the process of deleting a user.
On the user bar:

Go to the pane of the user to be deleted.

Click Delete.
 Confirm the deletion by clicking Yes.

This completes the process of deleting a user.

6.6.10 Adding user access cards using a reader
The Visitor Management System software module supports adding permanent and temporary user access cards 
using an access control reader. The reader to be used to add the cards is indicated on the Visitor Management 
System object's settings pane (see Basic settings of the Visitor Management System software module).

To add access cards to a user using an access control reader, do the following:
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1.

2.
3.

a.

b.

c.
4.

5.

Go to the user pane.

Insert the access card to be assigned to the user into the selected reader.
If the Confirm card entered by operator box is checked on the Visitor Management System object's 
settings pane, a Visitor Management System dialog will be displayed.

Click Yes if the access card being added is temporary. The object code and the card code are entered 
in the corresponding fields after the codes of previously added access cards, separated by spaces (1).
Click No if the access card being added is permanent. The object code and card code of the inserted 
access card are entered in the corresponding fields on the employee bar in place of the previously 
specified values.
Click Cancel to not add the inserted access card to the user.

If the Confirm card entered by operator box is not checked on the Visitor Management System object's 
settings pane, then the object code and card code of the inserted card will be entered in the corresponding 
fields on the employee bar in place of the previously specified values.
Click the Save button (2).

This completes the process of adding a card to a user using an access control reader.

Note

 Temporary access cards are deleted manually.

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6.7 Working with the Scanning documents application
Scanning documents is an Visitor Management System module software application. The application runs in a 
separate window.

6.7.1 Starting and stopping the application
To start Scanning documents, click Scan on the user bar.

 

The application window will open.

Note:

Fullscreen mode is recommended for your convenience when using this application.


Caution!

To use the Scanning documents application, you must first connect a scanner, and install drivers and 
software.


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To close Scanning documents, click the  button in the upper right corner of the window.

6.7.2 Scanning user documents with Scanning documents application
User documents are scanned as follows:
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1.

2.
3.
4.
5.

6.

Go to the control panel.

Select the type of document to be scanned from the Document name dropdown list (1).
Enter a name template for the output file in the corresponding field (2).
From the dropdown list, select the format for the output file (3).
Click the Add document button (4).
An appropriately named tab will open on the document type navigation panel.

Click Scan to start the scanning application (5).
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1.

2.
3.

4.

5.

After the scanning is complete, an image of the document will be displayed in the document type navigation pane.

6.7.3 Adding and deleting document types
To add a new document type, do the following:

Go to the control pane.

In the Document name field, enter the type of the document being added (1).
Click the Add document button (2).
The document type will subsequently be available from the dropdown list (1).
To delete a document type, do the following:
Select the document type to be deleted from the list (1).

Click the Delete document from list button (3).

The selected document type will then be deleted.

6.7.4 Editing an image
Editing a scanned image is performed in the image editor.

Note:

If the required document has already been scanned, it can be loaded from a file. To do this, click Select 
from file and indicate the path to the desired file (6).



Note:

Only types that were previously manually created can be deleted.

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1.

 

Image editing is performed using the image editor's toolbar and context menu.

 

Images are edited as follows:

To select a portion of an image, click the  button on the toolbar.
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2.

3.

4.

5.

6.

7.

8.

Select the desired portion of the image.

Selecting Cut selected from the context menu will leave only the selected portion of the image on the 
screen.

To clear the selection, select the corresponding item in the context menu.

To change the image size within the image editor, move the  slider on the 
toolbar.
To automatically select the best image size based on screen resolution and window size, click the 

 button on the toolbar.
To switch to image brightness and contrast settings, select Brightness/contrast from the context menu or 

click the  button in the toolbar.
In the Brightness/contrast window that opens, use the sliders to specify the desired image brightness and 
contrast. Then click OK to save the changes.

Note:

To cancel your changes, click the Cancel button.

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9.

10.

11.

12.

13.

To rotate the image counterclockwise by 90 degrees, select Rotate ->Rotate 90⁰ left from the context menu 

or click the  button in the control panel.
To rotate the image clockwise by 90 degrees, select Rotate ->Rotate 90⁰ right from the context menu or 

click the  button in the control panel.
To rotate the image by an arbitrary angle, select Rotate ->Rotate image from the context menu or click the 

 button in the control panel.
In the Rotate window that opens, use the slider to specify the desired angle of rotation. Then click OK to 
save the changes.

To save changes, select Save in the context menu or click Save on the control panel.

Note:

 Check the View box to immediately view the changes in the image editor.


Note:

To cancel your changes, click the Cancel button.


Note:

 Check the View box to immediately view the changes in the image editor.


Note:
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This completes the process of editing an image.

6.7.5 Assigning a photograph to a user in the Scanning documents application
A portion of an image or an entire image can be used as a user photograph, e.g. displayed on the user bar.

To assign a photograph to a user, do the following:

Select the desired portion of the image (see Editing an image).
Click Use as Photo on the control panel or select the corresponding item in the editing window's context 
menu.

The selected portion of the image will subsequently be displayed on the user bar as the user's photograph.

6.7.6 Deleting documents and images
Documents and images are deleted as follows:

Bring up the image's context menu on the document type navigation pane.

Select the Delete menu item.
The selected image will then be deleted.
Go to the document type navigation pane to the tab to be deleted.

To cancel your changes, select Cancel in the context menu or click Cancel on the control panel.
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Click Delete document on the control panel.

Confirm the deletion by clicking Yes.

The tab and all of the images in it will then be deleted.
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